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Master Software Series 
PREMIER+™ 2 Embroidery Ultra, Create Module/Application 

Windows and Mac Version 

 

Fun with Digitizing 
Tips and Techniques in PREMIER+™ 2 
Create 
Author: Janie Lantz 

 

PREMIER+™ 2 Embroidery Ultra Software  

Digitizing can be quick and easy, or complex and contemplative.  It’s often an art-
form, with each addition of a new embroidery object seeming to direct the flow of 
your design as it emerges from the software window.  

Users often asked questions about specific techniques, and using the tools for 
designing those techniques, include designing with Motif Lines for Appliqué or for 
Redwork, working with Fill Areas to design holes for open areas in the fill, or 
designing with Specialty Fills such as Motif Fills. 

Let’s take a closer look at ways to design with these tools, with a focus on Motifs in 
Lines and Fills. 

 

 If working in the Mac version and the steps vary, the specific Mac instructions 
appear in green and/or with an arrow , beneath or within the corresponding 
Windows step. 
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Before We Begin:  Reset All Modules 

Resetting modules before beginning a class or seminar ensures everyone will 
automatically browse to the default folders when opening or saving designs, that all 
toolbars will have the same appearance, and other default settings, such as hoop size and 
orientation, are reset to default. 

 

Tip:  Open PREMIER+™ 2 Configure and Reset All Modules if menus or icons appear 
differently or programs react differently than expected. 

 Open the PREMIER+™ 2 Embroidery desktop program folder . 1.

 In Mac, open Configure from Launchpad or from a shortcut you have made in 
the Dock. 

 Open PREMIER+™ 2 Configure . 2.

 In the Utilities tab, click Reset All Modules .   3.

 In Mac, select Quit Open Premier+™ 2 Apps, then click Reset all Apps.  No other 
steps are required, so click Close  

 Click OK in the ‘All modules will be closed’ prompt. 4.

 If any open modules didn’t close, select them in the background and then close 5.
them. 

 Click OK in the ‘Please confirm’ prompt. 6.

 Click OK in the ‘All modules are now reset’ prompt.   7.

 Click OK to close PREMIER+™ 2 Configure. 8.
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Motif Lines 
What is a Motif Line, and where can we utilize a Motif line in the Create 
module/application? 

Motif Line  creates an Open or Closed line of stitching utilizing the built-in Motif 
stitches or any custom Motif stitches you have designed in PREMIER+™ 2 Create. 

Open Motif Lines are not connected at their ends, and the Start and End points can 
be moved independently of each other, creating an ‘open ended’ line.  An Open Motif 
Line designed around a Fill (or appliqué) can be adjusted to leave space between the 
two ends, useful where you only want a border part way around the Fill or appliqué 
area. 

Closed Motif Lines have connected Start and end Points to define a closed area, so 
they always completely enclose the area inside.  Closed Motif Lines are designed to 
join smoothly for a continuous stitch.  

In the Properties for a Line, you may change a line so it is Open or Closed. 

Motif Lines can be designed with Quick, Freehand or Precise Create tools.   

An Open or Closed Motif Line can border an area with or without Fill, or can be free-
standing as a line of decorative stitches.   

Open Motif Lines are often used to design quilting designs, Redwork embroidery, or 
decorative border embroidery. 

 

Motif Line as a Border Around an Area 
Use the Shapes to quickly place a pre-defined Motif Line. Experiment with altering the 
properties of the Shape to give different looks to your design. 

Quick Create Motif Line using a Shape 

 In Windows, open Premier+™ 2 Embroidery  from the Desktop Program folder or 1.
a shortcut you have placed on your desktop. 

 In Windows, open PREMIER+ 2™ Create  from the QuickLink toolbar.  2.

 Click Cancel to end the Wizard and default to the last used hoop and the Draw 
tab. 

 In Mac, open Premier+™ 2 Create  from Launchpad  or from a shortcut 
you have placed on the Dock. 
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 Select Hoop  .   3.

 Change Hoop Group to Universal.   

 Change Hoop Brand and Machine Group to Universal.   

 Change Hoop Size to the 200mm x 200mm – Universal Square Hoop 3.   

 Set Orientation to Natural.   

 Click OK. 

 Double click the thread color band in the Design Panel.   4.

 Select a red thread color change.   

 Click OK. 

 Select the QuickCreate tab in the Ribbon Bar. 5.

 Select the QuickCreate icon  in the Create Mode toolbar . 

 Click the Fill icon  (not its attached arrow) to toggle it off (no longer highlighted). 6.

TIP:  Turn off the Fill if you want only a Motif Line as a border to an area. 

 Click the arrow on the Line menu, and select Motif Line.  7.

   
The default motif is a star.  Since Premier+™ 2 has many different Motif options, 
we’ll leave the default, and change it up after we make our shape. 

 Check to make sure the Appliqué icon  is deselected (not highlighted). 8.

TIP:  If the Appliqué icon is highlighted, simply click the icon (not its attached arrow) 
to toggle it off.  

 Select Shape 2, a circle, in the Shapes Gallery menu.  9.
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 Click Shape  to place a circle with Motif stars, the default Motif stitch. 10.

The Shape object is box-selected, and the box corner handles are 
blue.   

In Create, the blue select box corner handles indicate the ability 
to freely manipulate the selection while retaining original 
properties, such as density or stitch length, in the objects.  

The Create module / application works with stitch objects 
containing special code rather than actual live stitches, and the 
stitches are only generated when you Export Embroidery. 

The initial design size defaults to roughly 55 x 55mm. 

Adjust size with box select, and adjust object shaping with Point Edit mode. 

TIP:  Change the Grid size to .25”, .5”, or 1”to help you visually achieve a specific size.  
Grid Side is set in the View tab in Windows, or under the PREMIER+™ 2 Create menu 

 (Main menu bar) / Preferences in Mac. 

 Design Object size is adjusted by dragging corner handles.  Adjust the Motif Line 11.
object so the select box fills the work area. 

 In Windows, hold the CTRL and SHIFT keyboard keys and drag out on a corner 
handle to make the design object larger proportionally in Height and Width, but 
pinned at center to the original location. 

 In Mac, hold the alt/option and SHIFT keyboard keys and drag out on a corner 
handle to make the design object larger proportionally in Height and Width, but 
pinned at center to the original location. 

TIP: We are working with decorative stitches which may project a considerable 
distance out from the shape object’s outline.   

If the object is too large it will extend outside the hoop, and become too large to 
export and stitch in the selected hoop size. 

If the design elements extend outside the hoop, you can simply use the corner 
handles to adjust the select box, or you can use Scale to Fit Hoop to adjust the size. 
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 In Windows, select the Home tab. 12.

 Click the arrow on the bottom of Modify 

Block  to open the selection menu, and 
select Scale to Fit Hoop. 

 In Mac, select the Edit tab in the main 
menu bar, then Scale to Fit Hoop. 

 Select the Motif Line design object Frame in the Filmstrip. 13.

 Right click over the selected Frame in the FilmStrip. 14.

 Select Properties to open the Fill Area and Line properties box. 

TIP:  Select Properties to change only the selected objects.   

Select Global Properties to change all objects of that type within the 
working design window. 

Alternately, you can select Point Edit Mode  in the Select toolbar, at the bottom of 
the work area in Windows, or in the main toolbar at the top of the work area in Mac.   

When you are in Point Edit Mode, and can see the individual points defining the 
object’s outline shape, right click in the work area to open the Properties dialogue in 
Windows, or select Properties from a pop up menu in Mac. 

 At the top of the properties box for Fill Area and Line are settings to change Fill Type 15.
or Line type.   

 Fill Type is currently No Fill .   

 Line Type is Motif Line . 

To change up the Fill or Line Type, simply open the menu and select a different 
option, or select the ‘No’ option for no fill or line. 

However, you must have either a Fill or a Line selected to define the object.  You 
cannot select the No option for both. 
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 In the Properties dialogue below, select the Line tab, which contains the following 16.
options: 

 Stitch settings 

 Open or Closed Border 

 Contrast color for the border 

 Taper, to miter the Start and End of the design 

 Select the Appliqué tab, which contains these options: 17.

 Appliqué Method 

 Select Fabric 

 Appliqué Piece Margin and Match Placement Line 

It is simple to change objects from Line to Fill with Border to Appliqué, and any 
combination thereof, with the Properties menu. 

 Select the Line tab.   18.

 In Mac, click the Motif menu button . 

 Open the Group menu.   19.

Groups of stitches are Husqvarna Viking, Pfaff, Universal, and My Motifs (if you have 
designed and saved personal motif elements). 

 Select Universal in Group. 

 Open the Category menu.   20.

 Select Flowers and Leaves 2. 

 In Pattern select stitch 2 . 

 Leave Width and Height at the default size of 8mm.   21.

 In Mac, click OK to close the Motif properties.   

 Leave Fit to Line and Kern both unchecked.   22.

 Click Apply in Windows to see the change.   23.

 Click OK in Mac to see the change. 

 In Windows dialogue box, check Mirror, and then click Apply. 24.

 In Mac, right click over the Filmstrip Frame and select Properties. 

 Open the Motif menu. 

 Select Flip Vertical , and then click OK. 
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 Click OK to close the Properties dialogue box in both Windows and Mac. 25.

Mirror (Flip Vertical) flips the stitches across the shape’s outline, so they move from 
the inside of the circle to the outside of the circle for this design object.   

The Motif Line is once again too large to Export or fit into the selected hoop. 

 In Windows, select the Home tab, click the arrow on the bottom of Modify Block to 26.
open the selection menu, and select Scale to Fit Hoop. 

 In Mac, select the Edit tab in the main menu bar, then Scale to Fit Hoop. 

 Ensure the Motif Line Frame is selected in the FilmStrip. 27.

 Right click over the Motif Line object’s Frame in the FilmStrip.   

 Select Duplicate (Duplicate Selected).  

The duplicated object is slightly offset so you can easily verify it’s there.  The 
Duplicate also generated a new Frame in the Filmstrip. 

 Click Undo  (File/ Undo or Actions/ Undo Duplicated, or use the shortcut 28.
command Z). 

 Ensure the Motif Line Frame is selected in the Filmstrip. 29.

 Right click over the Motif Line’s Filmstrip Frame.    

 Select Copy, to place the design object (.edo object) on the Create Clipboard. 

 Right click over the selected Frame in the FilmStrip. 30.

 Select Paste.   

Paste places the new object directly over the original so they are exactly aligned. 

 Ensure the pasted (new) Motif Line Frame is selected in the Filmstrip, (the last Frame 31.
at the bottom of the Filmstrip). 

 Right click over the selected Frame .   

 Select Properties. 

  In Windows, Uncheck Mirror.  32.

 Open the Motif settings and deselect Flip Horizontal 

.   

 Click OK to close Motif settings, and OK to close the 
area and line properties. 

 Click OK to close the Properties dialogue box.  

You’ve created a perfectly sized and aligned double ring of mirrored motifs! 



  Page 9 of 28 

PREMIER+ is a trademark of KSIN Luxembourg II, S.ar.l.  All trademarks are used under license by VSM Group 
AB. © 2020 KSIN Luxembourg II, S.a.r.l 

 Click the next to last Frame in the Filmstrip (selecting the original Motif Line object). 33.

 Right click over the selected Filmstrip Frame. 

 Select Insert Color Change. 

 Select any thread color you like. 

 Click OK. 

 Select all the design objects in the Filmstrip, using one of the methods below. 34.

 Use CTRL and A on the keyboard. 

 Use command and A on the keyboard. 

 Hold down the CTRL key and click each Filmstrip Frame to highlight. 

 Hold down the command key and click each Filmstrip Frame to highlight. 

 Right click over any selected (highlighted) Frame in the FilmStrip. 35.

 Select Group to bind the objects together. 36.

Grouping will help you move all the objects together, or resize as a single set, etc.  To 
move the grouped elements, simply select the Group Filmstrip Frame, and make sure 

Box Select  is active. 

 Click Save As .   37.

 Hold the alt/option keyboard key and select File/Save As.   

 Browse to the desired folder.   

 Name the working (.edo) file DoubleMotifRing.   

 Click Save. 

 Click Export . 38.

 Select Actions, then Export. 

 Select .vp3 (or the preferred file type for your embroidery) in the File Format 
menu. 

 Adjust the Optimize for Sewing menu as desired. 

 Decoration is not active since we didn’t add any decorations to this embroidery. 

 Hoop Orientation automatically sets itself correctly based on the design size, 
and the selected machine. 

 Click OK (Continue). 

 Browse to the desired folder. 
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The File Name draws automatically from the .edo file name. 

 Click Export (Save). 

Don’t forget to use Send to mySewnet  if you have a compatible Wi-Fi enabled 
embroidery machine! 

One of the exciting benefits of designing in Create is the ability to make the working 
element larger, smaller, or reshape it in many ways without losing the initial quality 
of the stitches when you Export! 

 Use CTRL A or command A to select all. 39.

Alternately, you can click the Group Frame in the Filmstrip to select 
all the objects in the group. 

 Adjust the shaping into an oval by dragging corner handles. 40.

 Drag the box to recenter it in the hoop. 

Pay attention so your stitches are all within the grid area of your 
selected hoop. 

 Use Save As (alt/option / File / Save As) to resave the design as 41.
DoubleMotifOval. 

 Export the changed design File. 42.

Don’t forget to use Send to mySewnet  if you have a compatible Wi-Fi enabled 
embroidery machine! 

 

Now, how can you use these techniques in additional ways? 

How about selecting a design element and Duplicating it, then moving it up or down 
in the Filmstrip? 

Adjust the size of the new duplicate, for a third ring, or a smaller concentric inner 
ring. 

Change some of the stitch motifs for a different look. 

Have fun playing! 
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Quick Create Motif Line from a Picture 

Designing with Quick tools over a picture is a slightly different technique.  Let’s 
explore a few ways to use the Quick Create tools for designing using pictures.  

 Select File / New Window to open an additional program window. 1.

 Select File / New. 

 In Windows, select Load a Picture into the Paint Window.   2.

 Click Next.   

 Click Load a Picture .   

 Browse to Premier+2, Samples, Premier+2Emb, Pics2, Motifs.   

 Select Motif 1CMo24.  

 Click OK.   

 Click Next in Choose Picture.   

 Click Next in Rotate or Crop.  

 In Design Size, select Enter Design Size. 

 Click Change Hoop.   

 Change Hoop Group to Universal.   

 Change Hoop Size to the 200mm x 200mm – Universal Square Hoop 3.   

 Set Orientation to Natural.   

 Click OK. 

 In Enter Design Size, set Width to 190mm.  

 Click Next to go to Reduce Colors.   

 Click Finish. 

 Select the Quick Create tab. 

 In Mac, select Hoop .   

 Change Hoop Brand and Machine Group to Universal.   

 Change Hoop Size to the 200mm x 200mm – Universal Square Hoop 
3.   

 Set Orientation to Natural.   

 Click OK. 

 Click Load Background  in the Background tools. 
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 Browse to Premier+2, Samples, Premier+2Emb, Pics2, Motifs. 

 Select Motif 1CMo24. Click Open. 

 Click Move Background . 

 Hold the alt/option and Shift keyboard keys, and adjust the size so it’s about 
half a grid away from the hoop edge at right and left sides as you face the 
screen. 

 Right click and select Finish Move Background.  

Make sure Quick Create is selected in the Create Mode tools.  

 Double click the thread color band in the Design Panel.   3.

 Select any green thread color.   

 Click OK. 

 Click the Fill icon  (not its attached arrow) to toggle it off. 4.

 Click the arrow on the Line menu, and select Motif Line . 5.

 Make sure the Appliqué icon  is off (not highlighted). 6.

 Click Fill Area and Line  to open its 7.
Properties.  

 Change Group to Universal, Category to General 

Motifs 1, and select Pattern 3 . 

 Click OK. 

 In Mac, click Options , and then Fill Area and Line. 

 Change Group to Universal, Category to General Motifs 1, and select Pattern 3 

. 

 Click the Motif button to open the properties. 

 Click OK to close the Motifs, and OK again to close the Line properties. 
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 Click the QuickStitch icon . 8.

 Click inside one of the leaves.   

 Set Color Tolerance at Low, so the multi-
color highlight line is inside the leaf, as 
pictured.   

 Click OK. 

The Motif Line forms inside the leaf shape 
along the Color Tolerance line. 

 Click Undo  (shortcut is CTRL Z on the keyboard). 9.

 Click Actions, and select Undo Add Area, or 
shortcut with command Z. 

 Zoom in (use the zoom tools as desired) so only a 10.
portion of the line is visible, and magnified so you 
can easily cursor over the line. 

 If necessary, reselect QuickStitch icon . 11.

 Click ON the line in the picture (the tip of your 12.
cursor should be in the middle of the black line).   

 When Color Tolerance appears, you should 
see it’s little highlighted line along the lines 
of the stem and leaves.   

 Click OK to place the stitches. 

The Motif line forms along the entire drawing.  
Some areas have to double back to get from 
one area to another, and the result is some 
overlapping layers of stitches. 

 Open Play  , and play through the 13.
stitches to review how the design is formed.   

 Click Cancel / Close. 

 Click Undo  (shortcut is CTRL Z on the 14.
keyboard). 

 Click Actions, and select Undo Add Area, or shortcut with Command Z. 
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 Click the Trace menu  , and select Motif Line Trace.   15.

 Click on the black line in the picture.   16.

 Click OK to Color Tolerance.   

 Click Play  , and play through to see 17.
how the design stitches when traced. 

Trace uses running stitch lines to travel out 
and Motif stitch lines to travel back so there 
is less doubling of the motifs.   

The tradeoff is that with some stitches, the 
running stitch may peek through the 
decorative Motifs. 

 Click Cancel / Close. 

 Use Save As (alt/option, File/ Save As) to resave the design as QuickTrace Motif Line 18.
Leaves. 

 Export the changed design File. 19.

Don’t forget to use Send to mySewnet  if you have a compatible Wi-Fi enabled 
embroidery machine! 

 

Precise Create Motif Line as Redwork, using a Picture 

Use Precise Create tools and a picture to plan and exactly execute the embroidery as 
you want it to stitch. 

 Select File / New Window to open an additional program window. 1.

 Select File / New. 

 In Windows, select Load a Picture into the Paint Window.   2.

 Click Next.   

 Click Load a Picture .   

 Browse to Premier+2, Samples, Premier+2Emb, Pics2, Motifs.   

 Select Motif 1MMo01, a vining flower.  

 Click OK.   

 Click Next in Choose Picture.   

 Click Next in Rotate or Crop.  
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 In Design Size, select Enter Design Size. 

 Click Change Hoop.   

 Change Hoop Group to Universal.   

 Change Hoop Size to the 200mm x 200mm – Universal Square Hoop 3.   

 Set Orientation to Natural.   

 Click OK. 

 In Enter Design Size, set Width to 150 mm.  

 Click Next to go to Reduce Colors, and Reduce Number of Colors to 2.   

 Click Finish. 

 Select the Precise Create tab. 

 In Mac, select Hoop .   

 Change Hoop Brand and Machine Group to Universal.   

 Change Hoop Size to the 200mm x 200mm – Universal Square Hoop 3.   

 Set Orientation to Natural.   

 Click OK. 

 Click Load Background  in the Background tools. 

 Browse to Premier+2, Samples, Premier+2Emb, Pics2, Motifs. 

 Select Motif 1MMo01. Click Open. 

 Click Move Background . 

 Hold the alt/option and Shift keyboard keys, and adjust the size so it’s 15 grid 
squares wide (150 mm at the default 10mm grid). 

 Right click and select Finish Move Background.  

 Make sure Precise Create is selected in the Create Mode tools.  

 Double click the thread color band in the Design Panel.   3.

 Select any green thread color.   

 Click OK. 

 Click the Fill icon   (not its attached arrow) to toggle it off if needed. 4.

 Open the Line menu, and select Motif Line . 5.
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 Make sure the Appliqué icon  is off (not highlighted). 6.

 Click Fill Area and Line to open its Properties.  7.

 Click Options , and then Fill Area 
and Line. 

 Click the Motif button to open the properties. 

 Change Group to Universal, Category to Bean Stitches 1, and 
select Pattern 4. 

TIP:  Bean Stitches emulate the look of hand stitched embroidery 
with multiple strands of thread.  Stitch 1 is a standard triple-pass 
bean stitch.  Stitches 2 and 3 are angled with linking stitches.  
Stitches 4, 7, 10 and 13 add multiples of stitches and offset the 
stitch points to produce different weights and textures to the Bean 
Stitch Pattern motif. 

The image at right shows a 3 stitch repeat of each horizontal Bean 
Stitch. 

 In Mac click OK to close the Motif settings, to go back to the Line settings. 

 Select Fit to Line (to help prevent small breaks or gaps between segments of the 
line). 

 Click OK. 

When designing with Precise create tools, a little planning is helpful to optimize the 
stitch order and design a uniform look to the stitch-out. 

Look at the picture, and devise a plan that lets you get from section to section with 
the fewest motion or travel stitches possible. Manual digitizing is heavily influenced 
by the technique and skill of the digitizer, but learning some basics can help you 
achieve the look for which you’re striving. 

This design was planned to flow from left to right, with a back-track travel/motion 
stitch on half the flower so the stitch will end at the right side of the vine, making it 
suitable for endless borders. 

 Adjust the view using the Zoom tools to optimize your view of the picture for easier 8.
placement of points. 

You can use the Zoom slider bar while the Area or Line Tool is active! 
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 Select Create Area or Line . 9.

 Click the first point at the left (as you face the screen) end of the stem, and click 
points as shown.  

 Use CTRL + Click (Shift + Click) for square points to make corners or straight 
lines. 

 Place the number of points you need to design the curves and turns of the left 
section of stem and leaf. 

TIP:  If a point needs to be moved, hold the cursor tip over the point until you see the 

‘move’ symbol , then click and drag the point.  If moving a square point, hold 
down CTRL or command (Mac) to retain the point as square. 

 
 In Windows, right click once when you reach the flower to create a place to regroup 10.

and begin adding points around half the flower. 

 In Mac, right click and select Finish Drawing the Line. 

TIP:  The Freehand Point Create Area or Line tool  will remain active, so you can 
add more stitches. 

 Adjust the Zoom or view with the slider handles at right and bottom, so the top half 11.
of the flower is visible in the work area. 

I chose to work off the top half of the flower to the point where the right stem joins, 
and then use travel stitches to backtrack over the bottom half of the flower so I could 
add the Bean Stitches to the bottom of the flower from left to right, ending at the 
other stem. 

You could reverse and do the bottom half of the flower first if you choose, as there is 
no right or wrong method, only your personal style and technique. 

When the bottom half is complete, then work off the remaining stem on the right. 
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When you do need to use travel/motion stitches to optimize the stitch sequence, try a 
Running Stitch to travel out, and then return with the Bean stitch, so the layers don’t 
get too heavy and make sections of the embroidery look clumpy. 

 Cursor over the bow tie at the end of the first line of motifs. 12.

TIP:  If you can’t see a bow tie at the end, check to make sure the Motif Line object is 
selected in the Filmstrip.  Make sure the Create Area 
or Line tool is active. 

To prevent small jump stitches between objects, 
make sure you connect the start point of the next 
Motif Stitch object to the end (bow tie) of the last. 

When the cursor shows a small – attached, the next 
point will join with the last point marked by the bow 
tie. 

 Click the first point when you see the slash attached 13.
to the cursor, and then click additional points 
around the top of the flower to define the shaping of the Motif Line. 

 
 In Windows, right click once to end this stitch object, but leave the Create Area or 14.

Line tool  active. 

 In Mac, right click and select Finish Drawing the Line. 
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To make an unbroken stitching without jumps, add Running Stitches to travel back to 
the point where the left stem joins the leaf, and then add Motif Line stitches back to 
the point where the right stem joins the flower. 

 In the Line tools menu in the main toolbar, change the 15.

Motif Line  to a Running Stitch line .  

No need to turn off Create Area or Line to change to a 
different Stitch Type! 

 Cursor over the bow tie at the end of the second Motif 16.
Line, until the cursor shows the -. 

 Click points (using CTRL Click or Command Click for square points at corners) to work 17.
back to the join of the left stem to the flower. 

 In Windows, right click once to end this stitch object, and again to end the Create 18.
Area or Line tool. 

 In Mac, right click and select Finish Freehand Point Area or Line. 

Let’s copy and paste the running line, then change it to a Motif Line and reverse its 
stitch direction, so it’s exactly the same as the traveling Running Line for a precise 
stitch-out! 

 Click the Running Line Frame in the FilmStrip to ensure it is selected. 19.

 Right click over the selected Running Line Filmstrip Frame. 20.

 Select Copy. 

 Right click over the selected Running Line Filmstrip Frame. 21.

 Select Paste. 

Remember, Copy and Paste puts the pasted object directly over the copied object, 
perfectly aligned.  Duplicate would offset the new object. 

 Double check that the pasted Running Line is the highlighted (selected) Frame in the 22.
Filmstrip. 

 In Windows, select the Edit tab in the Ribbon Bar. 

 Select Reversal , and then Reverse Line. 

 In Mac, select Object in the menu bar, Reversal, and Reverse Line. 

Reversing the Line will make the stitches go back from the end of the running line, to 
the point where the right stem will begin, so we are once again stitching 
continuously! 
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 In the Filmstrip, right click over the last FilmStrip Frame, the newly pasted Running 23.
Stitch line. 

 Select Properties. 

 Change from a Running Stitch back to the Motif Line at the top of the properties 
dialogue box. 

 Click OK. 

 In Windows, reselect the Precise Create tab. 24.

 In the Fill Area and Line toolbar at the top of the work area, change the Running 25.

Stitch  back to Motif Line . 

 In the Filmstrip, make sure the last (lowest) Motif Line Filmstrip Frame is selected. 26.

 Click Create Area or Line  so it’s active.  27.

 Cursor over the bow tie for the end of the Running Line, and click the first point 28.
when you see the slash on the cursor. 

 Click more points along the line to finish out the last stem at the right. 

 In Windows, right click twice to end this stitch object. 29.

 In Mac, right click and select Finish Freehand Point Area or Line. 

 Click Play  , and play through to see how the design stitches when traced. 30.

 Click Cancel / Close.  

 View using Life View  so you can zoom and pan closely to inspect stitches in real 31.
life 3D view!   

 Cancel (Close) Life View. 

Life View  displays the design according the Export preferences you have selected 
in the Configure module / application. 

 Use Save As to resave the design as PreciseCreate Motif Line Flower. 32.

 Export the changed design File. 33.

Don’t forget to use Send to mySewnet  if you have a compatible Wi-Fi enabled 
embroidery machine! 
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A Unique Textured Appliqué Embroidery 
Open vs. Closed Border Line 

When do you use an Open Border Line vs. a Closed line? Let’s design an Appliqué, 
using Quick Create’s Shape tools, and ‘play around’ with something fun for the 
Appliqué Border!  Let’s border each half the Appliqué with a different thread color 
and mitered ends! 

 Select File / New Window to open an additional program window. 1.

 Click Cancel to exit the Wizard. 

 Select File / New. 

 Select Hoop  .   2.

 Change Hoop Group to Universal.   

 Change Hoop Brand and Machine Group to Universal.   

 Change Hoop Size to the 200mm x 200mm – Universal Square Hoop 3.   

 Set Orientation to Natural.   

 Click OK. 

 Double click the thread color band in the Design Panel.   3.

 Select a red thread color change.   

 Click OK. 

 Select the QuickCreate tab in the Ribbon Bar. 4.

 Select the QuickCreate icon  in the Create Mode toolbar . 

 Click the Fill icon  to toggle it off (no longer highlighted). 5.

TIP:  Turn off the Fill if you want only a Motif Line as a border to an area. 

 Click the arrow on the Appliqué icon , and click Select Appliqué Fabric. 6.

 In Appliqué Type, select Quick, and pick the Fabric Color of your choice. 

 Click OK. 

Selecting a Fabric also activates the Appliqué function. 

 Open the Line menu, and select Satin Line .  7.
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 Click Fill Area and Line to open its properties.  8.

 Click Options, and then Fill Area and Line. 

 Adjust Satin Width to 4.5mm, and Density to 4. 9.

 Select the Appliqué tab. 10.

 Select Pre-Cut Piece. 

 Check Match Placement Line, and set the offset number to 2, so it will be close 
to the center of the Satin Line border. 

TIP:  If you choose to select Standard Appliqué, some steps in the Appliqué will vary, 
and the Filmstrip Frames may contain different objects than those shown in the 
lesson steps, but can easily be changed up in the same manner. 

 Click OK. 

 Open the Shapes menu. 11.

 Select Shape 11, a diamond.   

 Click Shape  to place the diamond in the work area. 12.

 Adjust the size to fit your project.   13.

Use CTRL Shift drag a corner in Windows, alt/option Shift drag a corner in Mac. 

 Ensure the Satin Line Appliqué Frame in the FilmStrip is selected. 14.

 In Windows, select the Edit Tab.   15.

 Select Break Apart.   

 In Mac, select Object in the main menu, and then Break Apart. 

The FilmStrip Frames show the objects that define the Satin Line Appliqué. 

 Click to select the Filmstrip Frame with Satin Line (the last 16.
Frame in the FilmStrip). 

 Right click and select Properties. 17.

 Ensure Closed Border Line is not selected (Open Border). 

 Click OK.  

The border’s Satin Line has to be open (not closed) so that we 
can remove half of it, and then work with a copy to define the 
other side of our appliqué diamond.  If the Border was closed, 
the remaining half-line would become a closed triangle! 
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 Click Edit Points mode  (bottom, Select tools in Windows, top, Select tools in 18.
Mac). 

 Select the Home tab in Windows.   19.

 Click Delete Points .   

 In Mac, in the Control Panel, beside the Color Select box, select Delete Points 

. 

 Delete the point that shows the green Start or red End point.  In the picture 
below, that point is at the top of the Satin Line. 

  
 Delete the next point in the Satin Line (at the side corner, as shown). 

TIP:  The goal is to end up with only half of the appliqué bordered with the Satin Line. 

Your first Delete Point may delete the Start rather than the End, depending on how 
they are overlapped, and can vary from computer to computer.  As long as you end 
up with a border on either the right half or the left half of the appliqué, this 
technique will work. 

 Right click over the adjusted, selected Satin Line Filmstrip Frame in the Filmstrip and 20.
Copy. 

 Reselect the Satin Line FilmStrip Frame, right click over the selected Filmstrip Frame, 21.
and Paste. 

Remember, Copy and then Paste will put the new object directly over the copied 
object! 
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The pasted Satin Filmstrip Frame should be the selected object in the Filmstrip now. 

 Click Box Select  in the Select toolbar (bottom of work area in Windows, top 22.
toolbar in Mac). 

 Click the Flip handle  on the left side of the select box to flip the selected Satin Line 23.
side-to-side. 

 Click and Drag the select box to align the second half of the stitches into their correct 24.
position. 

TIP:  Select the View tab (View menu, View Mode), and select Object View   to 
help you see where the ends of this Satin Line should line up with the previous Satin 
Line. 

 In Mac, select View, View Mode, Object View Mode. 

  
When you have the two Satin Line object’s outlines properly aligned, change the 

View back to 3D View . 

 

Change the Stitch Direction 

Now, we need to make it stitch continuously!   

In the Filmstrip, both Satin Line elements show the End at their top corner, and Start 
at their bottom. This produces a break in the stitching with a Jump Stitch. 

The Double Stitch that precedes the two Satin Lines Starts and Ends at the top.   

Let’s Reverse Direction in the next to last Filmstrip Frame (Satin Line with Stop at the 
Top) so it will start where the Double Stitch ends. 
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 Select the Satin Line Filmstrip Frame with the green 25.
Start command at the bottom of the object (shown 
in the illustration as the next to last Filmstrip Frame). 

Remember, your Filmstrip Frame objects may be 
reversed, depending on which side the Satin Line was 
on the Appliqué when you deleted half the line. 

 Select the Edit tab in the Ribbon Bar. 26.

 Select Reversal , and then Reverse Line. 

 In Mac, select Object in the menu bar, Reversal, 
and Reverse Line. 

 Click Play  , and play through to see how the design stitches when traced. 27.

 Click Cancel / Close.  

The ends of the Satin Lines don’t have the correct angles to form a proper Diamond 
taper. 

 

Miter the Ends to form the Diamond Shape 

  Select the Frame in the FilmStrip that holds the Satin Line for the left side of the 28.
Appliqué.   

 Right click over the selected Filmstrip Frame and select Properties. 29.

 Change the Miter settings in the Line tab as 
shown: 

 Click OK. 

 Select the other Satin Line for the right side of the Appliqué.  30.

 Right click over the selected Filmstrip Frame and select Properties. 31.

 Change the Miter settings in the Line tab as shown above. 

The miter Start and End points use the same angle because the lines are reversed 
from each other. 

 Click OK. 32.

 The ends of the two Satin Line elements are now mitered nicely, and will stitch 
seamlessly! 
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Add a Second Color for the Second Satin Line 

Let’s make each half of the border stitch in a coordinating but different color! 

 Click the next to last Frame in the FilmStrip (the first half of the border’s Satin Lines). 33.

 Right click over the selected Filmstrip Frame. 34.

 Select Insert Color Change. 35.

 Select a new thread color. 

 Click OK. 

 

Add a Motif Fill over the Appliqué for Emphasis and Texture 

Motif Fill areas utilize the stitch motifs built into Premier+™ 2 software, plus any 
special stitch motifs we create and save into the system in MyMotifs.  Motif Fills are 
useful for quilting designs, texturing, and decorating large open areas in an 
embroidery design.  Our explorations wouldn’t be complete without touching on the 
Motif Fills and some fun ways to design with them! 

 Select the Double Stitch line Frame in the Filmstrip. 36.

This stitch object is the tack-down to secure the Appliqué Fabric. 

 Right click over the selected Filmstrip Frame. 37.

 Select Copy. 38.

 Right Click over the selected Filmstrip Frame. 39.

 Click Paste. 40.

 Right click over the newly pasted Filmstrip Frame (a second Double Stitch Line). 41.

 Select Properties.   42.

 Change from No Fill to Motif Fill .   

 Change the Motif to Group Universal, Category Geometric 2, and Pattern 9.

   
 Change the Size to 10.5 x 14mm, with Proportional checked.  

 On Mac, uncheck Proportional, and size to 10.5 x 14mm.  

 Change the Line to Double Zigzag  to make it more secure. 43.

 Click OK (click OK twice in Mac) to close the properties dialogue box. 44.
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 Click Life View  to zoom and pan to see how the Motif Fill looks over the 45.
Applique.    

 Click Cancel / Close.  

 Click Play  , and play through to see how the design stitches. 46.

 Click Cancel / Close.  

 

Add a Shaped Hole in the Motif Fill Area 

Did you know you can add holes to all the Fill-Type areas? 

 Click the Motif Fill Frame in the Filmstrip so it is selected. 47.

 Right click and select Properties.   48.

 Select the Line tab.  

 Check the box by Closed Border Line.   

We need to close the line for the Motif Fill so the hole area will have a closed inner 
border.  Otherwise, the border would likely be incomplete where the Motif stitches 
are incomplete. 

 Click OK. 

 Select the Precise Create Tab / Mode . 49.

 Select Hole . 50.

 Click points to define a hole in the Motif Fill.   51.

 Right click twice to end the tool (Right Click and select Finish Freehand Point 
Hole). 

 Check out the design with Life View  and Design Player  . 52.

 



  Page 28 of 28 

PREMIER+ is a trademark of KSIN Luxembourg II, S.ar.l.  All trademarks are used under license by VSM Group 
AB. © 2020 KSIN Luxembourg II, S.a.r.l 

Something to Play With:  Change Satin Line to Motif Line with Miters 

This last technique is probably the most challenging because the success will largely 
depend on which Motif Stitch you select, and how you adjust it.  It’s fun to play with 
though, so I’m tossing the idea in to get your creative energy flowing! 

 Select the left side Satin Line Frame in the Filmstrip. 53.

 Right click over the selected Filmstrip Frame and 
select Properties. 

 Change Satin Line to Motif Line  at the top of 
the properties box. 

 Change the Motif to Group Universal, Category 
Zigzag 1, Pattern 9, sized to 4.8 by 4.8mm. 

The size needs to be smaller so the stitch won’t overhand the applique edge too far. 

 Click OK (click OK twice in Mac). 

 Check out the design with Life View  and Design Player  . 54.

Now that you’ve played with changing the Fills, Lines and added a hole, start thinking 
about other applications for these tools and techniques! 

 Save and Export the embroidery. 55.

 Select File, and Export Appliqué Pieces to make a cutter template or print a paper 56.
template for the fabric. 

 Select File, and Print to make a template or a list of steps and thread colors for your 57.
custom Appliqué embroidery! 

 

When you stitch out your Appliqué design, use light fusible batting under the 
Appliqué Fabric to give an instant Trapunto look! 

 

The next step in embroidery creativity is up to you!   

Try out some of the techniques from today’s lesson, and see how you can utilize them 
as you design your next project in the PREMIER+™ 2 Create module/application! 

Remember, experimenting and trying new techniques with different looks is how you 
learn and grow. 


